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NOTE CHANGED LOCATION

Fulton Room 112
First Floor - Fulton Building

New Users & Wizards 6:30 p.m.
Main Meeting 7:30 p.m.

What’s New at Symantec?

The June meeting will feature Jerry Hoehn of LAN
One, a local affiliate of Symantec Corporation. Jerry
will have the latest news about Symantec’s solutions
for security and productivity. Most users are familiar
with the company’s Norton product line, including
the famous suite of utilities, anti-virus, and firewall
software. Symantec also provides WinFax Pro and pc
Anywhere for FAX and remote connectivity. It’s
VelociRaptor enterprise firewall and VPN security
software offer the same high-standard of protection
for entire corporate networks.
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The School Bell
News From MPCUG Education Services

By Gil Hennon, Education Services Coordinator

Go to the place where you work. Shout
out, “Can anyone hear me?” If you get a
response, shoot to kill. It’s a homicidal
maniac!

That grim, real-world analogy on the
Virus Myths and Hoaxes Website (http://
vmyths.com) was inspired by the mass
hysteria surrounding a recent email chain
letter alleging that a harmless PC file is a
virus. Unless something highly unusual
has occurred, JDBGMGR.EXE is not a
virus. It’s an ordinary Windows operating
system file that supports Java functions.
But if you receive the hoax email and
follow its instructions, you’ll delete it
instantly.

The forwarded email message arrives
from someone you know–probably a
friend that you trust. Your friend may
have added a comment, such as, “I had
this virus on my own computer, and I’m
afraid I may have sent it to you.” That’s
pretty alarming, especially if you consider
your friend to be a rational and reasonably
careful person. Then the forwarded por-
tion raises your blood pressure even
higher. It gives detailed instructions for
using the Windows search function to find
a file named JDBGMGR.EXE. Chances are,
you will find it on your computer. It’s on
hundreds of millions of PCs. “DO NOT
CLICK ON IT,” the email shouts in upper-
case characters. The instructions tell you
to delete it, then empty your Recycle Bin
to be certain it has been completely oblit-
erated. Lastly, you are supposed to for-
ward the warning to everyone with whom
you exchange email. If nothing else in the
instructions raised your suspicions about

the truthfulness of the message, that last
step should be a red flag. Hoaxes don’t
work if they don’t get exposure, so nearly
every one of them recommends spreading
it around.

So, how much damage did you do if
you deleted JDBGMGR.EXE? Not much,
really. A few Java functions will not work
and will display an error message on the
screen. If you have Java turned off in your
browser preferences, you’ll never know
the file is gone. Otherwise, you may need
to copy the file from someone else’s com-
puter and put it back where it belongs. If
you happen to run Windows ME, 2000, or
XP, there’s even a decent chance that
Windows will notice that JDBGMGR.EXE
is missing and may automatically replace
it from the backup copy in the DLL Cache,
assuming you didn’t find and delete it
from there too.

A similar hoax was perpetrated last
year. The message targeted a different
Windows file, SULFNBK.EXE. Coinciden-
tally or not, that hoax began in April of
2001, and the current hoax began in April
of 2002. Do you smell an April Fool joke
aroma here? SULFNBK.EXE is the file that
processes long file names. Killing it forces
the computer to truncate file names to fit
the old 8.3 character limitations.

But no one would be gullible enough
to delete a file just because an email
message said it was a virus, right? If you
believe that, I’d like to sell you a bridge in
Brooklyn! Several local businesses were
disrupted while worried computer users
deleted JDBGMGR.EXE as the email
circulated. Often it was forwarded by a
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This newsletter is a monthly
publication of the Memphis PC Users
Group, Inc. (MPCUG) Copyright ©1998
MPCUG. Unless otherwise indicated,
articles may be reprinted in other non-profit
publications without express permission,
subject to the following conditions. Full
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your use of same constitutes your
agreement to hold us blameless.

Memphis PC Users Group, Inc.
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Memphis, TN 38124-1756
Internet: www.mpcug.org

Information Line: 901-375-4316

well-meaning, albeit clueless staff member. Many users
who deleted the file probably should have known better.
Typically they immediately ran a virus scanning utility
without getting a hit, then still deleted JDBGMGR.EXE.
Maybe they trust the friend who forwarded the warning
more than they trust their anti-virus software. While there is
a very slight chance that some brand new virus is not recog-
nized by virus scanning software, you are usually safer
trusting the virus scanner than an email from someone
totally unfamiliar with your computer.

A Microsoft employee who prefers not being identified
by name expressed incredulity when told about the file
deletions. “How many more files will gullible users delete
before they finally self-crash their own computers?” he
wondered.

During April and May, the “JDBGMGR.EXE virus”
email warning circulated so widely that the episode has
grown beyond hoax proportions. It is now being considered
a full-fledged Urban Legend! Don’t fall for it! When your
computer is running okay, don’t delete any file without
knowing the consequences. Like my grand-pappy used to
say, “If it ain’t broke, don’t fix it.”

MPCUG Education Services has more good tips and
help to make your computer happy. Join the New Users or
Wizards session immediately prior to the main meeting
each month. You’ll be glad you did!

Have you ever wanted to save a docu-
ment or media file from a Web page,
but were unable to keep the associated
application on your own computer from
opening or playing the file? Installing
new software often changes a default
action of “save as” to “open” or “play.”
So when you want to save something to
a file, such as a Word doc or an MP3
file, it opens or plays instead. To check
the current default action and change it,
open Windows Explorer and select
Folder Options from the View menu.
Click the File Types tab and find the
correct extension. Click the EDIT button.
The current default action is high-
lighted. Select and highlight a new
default action if you want to change it,
then click the SetDefault button and OK.

The
Wizard’s
Tips
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Reviewed by Bill Luber

When I upgraded my PC I had one
custom built to my requirements. That
way I wouldn’t have to immediately
consider add-ons.

My new PC had Windows XP Home
installed as the primary operating system.
This proved to be better than Windows 95,
98 or ME.  It was more stable and per-
formed better with tasks that had caused
me to have to reboot regularly in Windows
98.  But, one thing was missing. My work
required connectivity options. So I broke
my initial vow not to add anything to my
system. I added Windows XP Pro.

This, of course, would replace my
current version of XP Home and wouldn’t
really be an add-on. So, maybe I kept my
vow after all.

Why did I think I needed to do this?
Let’s look at the advantages and disadvan-
tages — for me.

The advantages
First, I get to keep everything I gained

in Windows XP Home. Second, I gained the
ability to access my computer remotely, if
necessary. Third, I gained greater security,
including the ability to encrypt files and
folders. Fourth, although I have a single
processor system I could upgrade to a
multi-processor system and be able to
take advantage of it without having to
change out the operating system. Fifth I
also gained the ability to work in a more
integrated manor with other Windows
servers and management solutions.

This is the most important feature for
me because I have a requirement to begin
supporting locations around the world.
That need will only become greater as
time goes on — managing users and
servers around the globe while not physi-
cally being there to work locally on the

systems. The communications capabilities
inherent in the Windows XP Pro operating
system will allow me to do my work
easier and with more accuracy. That, for
me, is a big plus.

The Disadvantages
First, the requirement for the hardware

to run any of the XP operating systems.
There is a lot of older equipment that will
not run any addition of the XP operating
system, so make sure yours will before
purchasing it and trying to install either
Windows XP Home or Windows XP Pro.

Second is the question:  do you need
this level of operating system for yourself
at home? Probably not for home. This
level of operating system is for the profes-
sional who has special requirements. You
probably do not need this level of capabil-
ity in a home machine, but it is nice to
know that the Windows XP Home edition is
just a subset of Pro. The Home version of
the XP has the same capabilities as XP Pro
without the bloat for the extra communica-
tion and security features that a profes-
sional needs.

Third are the upgrade paths. You can
only upgrade from Windows 95 or earlier.
If you get a machine with XP Home on it
you will not be able to upgrade it to
Windows XP Pro.  You simply have to
reformat and install clean which means
you would have to buy a full copy of
Windows XP Pro – a more costly option.
With that said I can definitely recommend
Windows XP Pro for what it is best at, but I
can also recommend Windows XP Home for

Windows XP Pro
Software Review
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what the home user needs.
Oh, I’m sure that you

will find Microsoft will
have to patch holes in the
system. No one builds a
system this big without
problems that have not
been found yet and fixed.
But that is normal and not
to be considered unusual.
Just keep up with patches
when they are available
and you will be okay. If
you have this or any
operating system at home
and use the Internet (or
just connect to the Internet
even if you do not use it),
remember to add a good
firewall and virus soft-
ware. You may not go
where viruses or hackers
reside, but you can be
sure that they will come
looking for you (not
personally, but because
you are there – on the
Internet).

Windows XP Pro
www.microsoft.com/
windowsxp
$190.00 Upgrade;
$299.00 Full Copy
Prices vary depending on
where you obtain a copy

Reviewed by Jack Merrill

This book would be good for
a first time user of Windows XP
and as a reference book for the
rest of us. The contents are
comprehensive and well orga-
nized. Most tasks are described
in no more than 7 steps. The
book is simply and clearly laid
out. The illustrations are color-
ful. A glossary and index are
included.

Installing XP on a blank hard
disk is covered step by step as is
installing XP as an upgrade to a previous version of Win-
dows. It details how to activate XP but does not try to ex-
plain why Microsoft thinks this necessary to fight piracy.
You’ll learn how to create and name restore points before
doing any significant upgrade to hardware or software. If
the installation is unstable or unsatisfactory you can return
the system to a restore point.

Only three criticisms of the book are worth mentioning:
the colorful screenshots would be more readable if they
were larger, and neither Wordpad nor remote assistance are
covered.

All the basics and many details of windows, the desk-
top, files, folders, printing and using a mouse are ex-
plained. Many of us fail to backup our data files ad-
equately. XP provides – and this book elaborates on – good
methods of file and system backup.

Music and movie making are features of XP that will be
attractive to many people. Finding music on the Internet
and recording it are discussed. Working with digital pic-
tures as either filmstrips or slide shows are detailed. A CD
burner is included. Setting up networks and sharing files
and printers are covered. Other topics include synchroniz-
ing files between a notebook and a desktop, sharing an
Internet connection, Windows Messenger, and publishing a
file to the Web.

How to Use Microsoft Windows XP by Walter Glenn.
2001. SAMS. $30. 304 pages. www.samspublishing.com

How to Use
Microsoft Windows XP

Book review
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plot. Notice how I am
writing short action sen-
tences? E. B. White would
be pleased (I hope).

Hot Text is a writing
book you can use to teach
yourself. Few teachers
cover grammar and writ-
ing style after junior high.
The review would do
most of us a lot of good.

The book is very
suitable for an Internet
journalism writing class. It
builds on sound writing
principles, then adapts
them to the needs of the
Internet.

You’ll also learn about
Web design and adapting

that design to the needs of
real people, including
people with special needs.
The chapters are short –
built around a single idea.
The authors provide
before and after examples
of written text. Later,
you’ll find case studies to
drive home the major
principles.

I want to come back to
the last quote: “write so
your pages will be
found.” Early in the book
the reader is directed to
the Challenges section of
www.webwritingthatworks.com.
I went. I looked. I couldn’t
find the Challenges sec-
tion. Bummer.

The Web really is a
moving target. I think
serious writers will find
the book an important
reference.

Hot Text: Web Writing
That Works by Jonathan
and Lisa Price. 2002.  New
Riders. $40. 500 pages.
www.newriders.com

Reviewed by
Rick Fischer

Too bad our newslet-
ter is not in color. The
book cover is red. Very
red. You may recall an-
other book that was
known as “the little red
book.” This one is bigger,
but has thoughts that are
simple and worth repeat-
ing.

“The more you know
about your visitors, the
better you can write for
them.”

“Never ask for the
information the consumer
has already given you.”

“The document. . . [is]
just another object, con-
taining other objects
nested within. . . .”

“Write. . . less text.”
“Make each paragraph
short.”

“Delete marketing
fluff.”

“Write so your pages
will be found.”

This is a sample.
Shouldn’t give away the

Hot Text: Web Writing That Works
Book Review

Destiny is no matter of chance. It is a matter of
choice. It is not a thing to be waited for; it is a

thing to be achieved.
- William Jennings Bryan
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SIG Council:
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Website:
Michael J. Heinrich, Webmaster  heinrich@usit.net
Susan Stubbs - 2stubbs@bellsouth.net

Special Interest Groups (SIGs)

Clipper (4th Monday, 7 p.m.)
Nils Pallesen - 366-9673 - 72234.1027@compuserve.com

Investment (4th Saturday, 10 a.m.)
George Pearson - 761-0161 - gpearso2@midsouth.rr.com

New User (4th Wednesday, 6:30 p.m. - Southwest TN Comm Coll)
 Gil Hennon -  396-4173 - aghennon@onemain.com

WordPerfect/Corel (3rd Monday, 7 p.m.)
 Sue Crawley - 363-3681 -  SueCrwl@aol.com

 Hardware (1st Saturday, 10:00 am, White Station Library)
Jim Ingram - 683-9342 - jimingram@excite.com

Wizards (4th Wednesday 6:30 p.m. - Southwest TN Comm Coll)
John Schuster - 662 236-4168 - umjohn@bigfoot.com
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For up to the minute information and special updates be
sure to check our webpage at:

WWW . MPCUG . ORG
MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY SATURDAY

JUN

2002
24

CLIPPER

25 26
MAIN

MEETING

27 28 29

JUL

2002
1 2

DOT.NET

3 4 5 6
INTERNET

HARDWARE

JUL

2002
8 9 10

NEWSLETTER

MAILING

11
VISUAL STUDIO

12 13
WEB WRITERS

MS OFFICE

JUL

2002
15

WORDPERFECT

16 17 18 19 20

JUL

2002
22

CLIPPER

23 24
MAIN

MEETING

25 26 27
INVESTMENTS

JUL-
AUG

2002

29 30 31 1 2 3
INTERNET

HARDWARE
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Meetings
General Meeting
All meetings are held at Southwest Tennessee Community College on
the fourth Wednesday of every month unless otherwise noted. Because
of Christmas holidays, no meeting is scheduled in December. Pre-
meeting sessions for New Users and Wizards begin at 6:30 p.m. and
the main event starts at 7:30 p.m.

SIG Meetings
All SIG meetings are held at  the White Station Branch of the Memphis
Public Library unless otherwise noted.

Affiliations
The MPCUG is a member of the Association of Personal Computer User
Groups (APCUG).

Other Memphis Area Computer Groups
AMUMS: Micro User Group at University of Memphis - Barbara Okerson 678-3682

AutoCAD: AutoCAD Users Group - Jim Prewett 382-0885

Clarion: Clarion Users Group - Timothy Jordan 767-8719

CCAM: Computer Consultants Association of Memphis - Jessica Morris 382-8459

DPMA: Data Processing Management Association - 680-1268

EDI/EC User Group: Jim Story 753-0500, ext. 341

KPCUG: Kirby Pines Computer User Group - Bob Nichols 360-9262

MADBUG: Memphis Area DB2 Users Group - Betty Stanley 325-5394

MAG: Memphis Amiga Group - Brian Akey 278-6354

MASH: Memphis Atari Systems Hobbyist - Bruce Leach 385-8195

MCCUG: Memphis Color Computer Users Group - B.J. Seaton 682-8737

MCTA: Microcomputer Technology Association (State Tech) - Doris Stepp 755-6685

MCUC: Memphis Commodore Users Club - Charlie Wirth 386-3337

MSMRUG: Mid-South Midrange Users Group - Jill Herrin 753-0500

TI99/4A: Mid-South TI99/4A Users Group - Gary Cox 358-0667

Memphis Area
Bulletin Board
Systems

If you would like your Bulletin
Board listed here, notify Gil Hennon -
aghennon@onemain.com

LindenRoom - Wildcat
901-458-9001
Sysop: Tracy Franklin

Pyramid BBS - Wildcat
901-372-7912
Sysop: Dan Rook

Public Seismic Network -
RBBS
901-360-0302
Sysop: Charlie Rond

TIPS BBS - Major BBS
901-542-9060
Sysop: Tim Hackworth

Crystal Clear Ideas BBS
901-327-2500
Sysop: Carlton Smith
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Memphis PC Users Group Membership Application

Date: ___/___/___ Membership #   ___

Name: (Last)_________________________ (First)_________________________
(M.I.)__________
Mailing Address: ________________________________________Birth Date: ___/___/
___
City: ______________________________ State: __________ Zip: ___________ - _____
Home Phone: (_____) _______________ Business Phone: (_____) _______________
Fax Number: (_____) _______________ E-mail:
___________________________________
Employer: ___________________________________ Position:
_________________________

Dues: $35 per year
For office use only
Check#: ___________ Amount: __________ Date: ___/___/___ Initials:________

Bridge the Gap
Product Member Telephone Time to call
Adobe Photoshop Gil Hennon 396-4173
CA-Clipper Nils Pallesen 366-9673
Corel WordPerfect Gil Hennon 396-4173
DOS John Schuster 662-236-4168 Evenings
InstaCalc 3 Les Owen 372-3987 8 a.m. - 10 p.m.
Internet T.R. Cardwell 377-9209 Evenings
PageMaker Les Owen 372-3987 8 a.m. - 10 p.m.
MS dot.net Jim McGee 683-4347 M-F: 9 a.m. - 9 p.m.
MS PowerPoint Gil Hennon 396-4173
Professional Write Les Owen 372-3987 8 a.m. - 10 p.m.
Quattro Pro Gil Hennon 396-4173
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Shortcuts, special effects, and productivity ideas submitted to Microsoft by Word 2000 users and
posted on the Mindshare pages at http://www.microsoft.com/office/previous/tips/word2000.asp

Use Your Keyboard to Quickly Change the Case of Text
From K.Venkatesh, Tamil Nadu, India
Here’s how you can use your keyboard to quickly change the case of text in Microsoft Word: Select
the text you want to change and press SHIFT+F3. Each time you press the F3 key, the text case
switches between Title Case, UPPERCASE, and lowercase.

Paste Using the INSERT Key
From Chody Trajano, Springfield, Virginia
Did you know that you can assign the Paste command to the INSERT key on your keyboard? That
means you only have to use one key to paste the contents of your Clipboard into your document.
Here is how to set it up:
1. On the Tools menu, click Options, and then click the Edit tab.
2. Select the Use the INS key for paste check box to enable this feature.
3. Click OK.
Now, each time you press the INSERT key, you will paste the contents of the Clipboard into your
document.
Editor’s Note: Choosing this option disables the default function of the INSERT key in Microsoft Word that
enables you to switch between insert typing mode to overtype mode.

Use Word 2000 to Do Your French (or Spanish) Homework
From Marcial Lapp, Bloomfield, Michigan
I am a student in high school and engaged in French language courses. The fact that Office 2000
can tell me when I have misspelled a word, or even if my French grammar usage is wrong, is ex-
tremely time saving and it gets me an A on the papers I write.
Editor’s Note: Microsoft Word 2000 automatically detects whether you are typing in English, French, or
Spanish, and uses the appropriate spelling or grammar checker for that sentence.

What’s This? Find Out What Formatting is Applied to Text in Word
From William Holmes, United Kingdom
To find out what formatting (fonts, style, alignment, etc.) is applied to a paragraph:
1. On the Help menu, click What’s This?.
2. When the pointer becomes a question mark, click the text you want to check. Then a message will
appear describing the formatting in that section.
3. When you have finished checking your text, press ESC.

Don’t Lose Sight of Your Column Headings in Word
From Al Dyer, Cumming, Georgia
When you create a table in Microsoft Word, you can use column headings to describe what infor-
mation is in each column. But if you have a table that spans multiple pages, you lose the headings
after the first page, so it’s hard to tell what each column topic is. Here’s how to keep those headings
visible:
1. Select the first row or rows of your table.
2. On the Table menu, click Heading Rows Repeat.
Now Word automatically repeats the table headings at the top of subsequent pages.

Microsoft Mindshare’s
            Word 2000 Tips & Tricks
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Editor’s Note: Word automatically repeats table headings on pages that result from automatic page breaks,
but not if you manually insert a page break. Also, repeated table headings are only visible in Print Layout
view or when you print the document.

Save All Your Word Documents at Once
From Nancy Schoh, La Crescent, Minnesota
If you know the “secret” key, you can save or close all of your open documents in one step.
1. Hold down SHIFT and click the File menu. When you hold down SHIFT, two new options appear
on the File menu: Close All and Save All.
2. To save all your open documents at once, click Save All. Or, to close all your open documents,
click Close All; Word will prompt you to save your changes before closing any documents.
Editor’s Note: The Close All command also works in Excel.

Speed Up Your Typing with AutoCorrect
From Lance LaMee, New Smyrna Beach, Florida
If you find yourself typing long words again and again, you should consider setting up typing
shortcuts, so you only need to type in part of the word and Word fills in the rest. For example, if I
need to type New Smyrna Beach (the town where I live), I just type NSB; then I press the
SPACEBAR, Word automatically spells out all the words. Here’s how I set up this shortcut:
1. On the Tools menu, click AutoCorrect. Select the Replace text as you type check box.
2. In the Replace box, type an abbreviation you will remember, for example, NSB.
3. In the With box, type the complete spelling of the word, for example, New Smyrna Beach.
4. Click Add.
5. Repeat steps 2 and 3 to add additional terms, then click OK.
You can also use this tip to quickly type people’s names, technical terms, anything you want. And
once you add a term to your AutoCorrect list, it also works in PowerPoint and Outlook as long as
you use Word as your default e-mail editor.

Type Out a Table in Word
From Vishal Chitkara, Edmonton, Alberta, Canada
You can create tables in Microsoft Word by simply typing out a string of PLUS SIGNS (+) and MI-
NUS SIGNS (-). Start the row with a PLUS SIGN (+) and then type MINUS SIGN (-) until you have
the column width you want. To add a new column type PLUS SIGN (+) again. When you’re done
type a final PLUS SIGN (+) and press ENTER. Word turns your text into a table. To add more rows
to your table, move to the last cell in the table and press TAB.
Editor’s Note: If this tip doesn’t work for you, then you need to turn on the AutoFormat feature in Word. To
do this, on the Tools menu, click AutoCorrect. Then, click the AutoFormat As You Type tab and select the
Tables check box.

Select Columns of Text in Word
From Rajendra Khade, Maharashtra, India
To select a vertical block of text in Word, such as a column of numbers, press and hold down ALT,
and then drag your mouse over the text. Then, you can delete it or copy it into another file. So easy!
Editor’s Note: If your column of text is inside a Word table, you will not be able to use this trick to select it.

Move Images in Word to the Exact Position You Want
From Fred Feuermann, Vancouver, British Columbia
When you position an image in a Word document, it automatically aligns (or snaps) to an invisible
grid, which helps keep everything lined up. If you ever need exact control over the placement of
your image, you can temporarily override the grid by pressing the ALT key as you drag the object
into place. You’ll notice that the image moves smoothly and not in increments along the grid.
Editor’s Note: This tip works as long as the image is not set to be in line with the text. To make sure it works
for you:
1. Double-click the image, and select the Layout tab.
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2. Under Wrapping style, choose any style except In line with the text.
3. Then, click OK.

Quickly Replicate Text or Graphics in Word
From Tim Graves, Shropshire, United Kingdom
Here’s a quick way to make copies of text or graphics in Word:
1. Select the item or text you want to copy.
2. Press and hold down the CTRL key.
3. Then use the mouse to drag the item to the desired position.
A copy of the original item is made right where you want it. This is helpful when you’re creating a
document that will include a lot of repeated text or images.

Find Your Place in Word Documents
From Nicolien Gooch, KwaZulu/Natal, South Africa
If you are working on a long document, it’s easy to lose your place. With Microsoft Word docu-
ments, you can pick up where you left off in your last editing session because Word keeps track of
the last three locations where you typed or edited text. Just press SHIFT+F5 immediately after
opening the document, and the cursor will appear at the exact point where you last made a
change. To reach the previous two editing locations, press SHIFT+F5 until you reach the location
you want.

Add Attractive Horizontal Lines in Word
From Collin Delker, Salina, Kansas
It’s easy to add a variety of horizontal divider lines to Word documents. To create a solid, black line
for example, type three HYPHENS (-) at the beginning of a new paragraph and then press ENTER.
Typing three UNDERSCORES (_) will make a thicker line, and so on. The list below makes other
types of lines:
— (Three HYPHENS) ___ (Three UNDERSCORES)
=== (Three EQUAL SIGNS) ### (Three POUND SIGNS)
*** (Three ASTERISKS) ~~~ (Three TILDES)
Editor’s Note: If you’re having trouble making this tip work, try this:
1. Select AutoCorrect from the Tools menu.
2. Click the AutoFormat As You Type tab.
3. Then select the Borders check box under the Apply as you type heading.

Check Spelling in Only a Portion of Your Word Document
From Joseph Spracklen, Aberdeenshire, Scotland
If you see a spelling mistake, you can correct it quickly without checking the entire document. Just
right-click the misspelled word, and then select the spelling correction you want from the shortcut
menu. To find the next misspelled word in the document, press ALT+F7.

Increase or Decrease Line Spacing in Word
From Nikolaos Bessis, Pireas, Greece
To quickly change the line spacing of a paragraph in Microsoft Word:
1. Select the text you want to change.
2. Do one of the following:

-To set line spacing to single-space lines, press CTRL+1.
-To set line spacing to double-space lines, press CTRL+2.
-To set line spacing to 1.5-line spacing, press CTRL+5.

Insert Current Date and Time in Word
From R. S. Karthik, Nashville, Tennessee
You can insert the current date or time in a Word document using keyboard shortcuts. Here’s how:
1. Position the cursor where you want to insert the date or time.
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2. Do one of the following:
-To insert the date, press ALT+SHIFT+D.
-To insert the time, press ALT+SHIFT+T.

Keep Words Together with a Nonbreaking Space
From Tina Dorsey, New Cumberland, Pennsylvania
Have you ever been typing a paragraph in Microsoft Word and had a multiword phrase, such as a
person’s name, get separated onto two lines? You can keep that phrase or name together by insert-
ing a nonbreaking space. To create a nonbreaking space, select the space after each word in the
phrase (except the last word), and press CTRL+SHIFT+SPACEBAR.

Take the Synonym Shortcut
From Daniel Jang, Vancouver, British Columbia
Find that word you’re looking for fast. You can find a common synonym for a word without using
the Thesaurus command. Just right-click the word and point to Synonyms on the shortcut menu.
Then, click the synonym you want, and it automatically appears in place of your original word.
Word will sometimes supply antonyms for the selected word, for those times when you only know
what you don’t mean to say.
Editor’s Note: You can access the full thesaurus by clicking Thesaurus on the shortcut menu.

Get More-Precise Measurements in Word
From Vishal Chitkara, Edmonton, Alberta, Canada
If you use the horizontal ruler to specify the placement of tabs, margins, and page objects, this tip
will help you lay out your pages with more precision. By default, ruler measurements are limited to
one-tenth of an inch. For example, if you click on the ruler to set a margin or tab, you can set it at 1.5
inches, but not 1.48 inches. To set more-precise measurements (to one-hundredths of an inch), hold
down the ALT key and, while you click on the ruler or margin, make your adjustments to the tabs.

Edit Text in Print Preview
From Michael Hernandez, Loma Linda, California
Sometimes when you view a Microsoft Word document in Print Preview mode, you notice adjust-
ments or edits you’d like to make to graphics and text. Did you know you can make those changes
while you’re still in Print Preview mode? Here’s how to do it:
1. Click Print Preview on the File menu.
2. Click the text in the area you want to edit. Word zooms in on the area.
3 Click Magnifier on the Print Preview toolbar. When the pointer changes from a magnifying glass
to an I-beam, you can begin making your changes to the document.
4. To exit Print Preview and return to the previous view of the document, click Close.

Add Fake Text to a Word Document
From Sheri Pulis, Sacramento, California
Here’s a handy function you can use whenever you need to fill a page with fake text. For example,
to demonstrate a feature in Word or to work with page layout and design. In a Word docu-
ment, type =rand(4,5) and then press ENTER.
The numbers in parentheses correspond to the number of paragraphs (4) and the number of sen-
tences per paragraph (5). You can change the numbers in parentheses to put more or less text on the
page. Or if you want one long paragraph, just place one number in the parentheses, which will
designate the number of sentences that should appear in the paragraph.

So much of what we call management consists
in making it difficult for people to work.

- Peter Drucker
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chapter. Make sure you
read it because many of
the graphic issues in
making Web pages are in
this final chapter. This
chapter includes working
with graphics to make a
navigational menu with
rollover effects, which is
quite a nice touch on
many Web pages you see
on the Internet today.

The Web resources
index pages in this book
provide some excellent
Websites to visit

to find out about Web
graphics. I found these
URL listings faster than
trying to do a search
through Google.

I am still reading some
sections of this book right
now. It is more of a refer-
ence style book for me. I
would definitely have
your Photoshop/Imageready
application open while
reading this so that you
can work through the
tutorials. This seems to be
the best approach towards
understanding the book’s
presentation, but it does
take longer to read the
book this way. Working
on one chapter at a time
very slowly will have you
mastering  the techniques
in the book.

I give this book a good
review, and as always, the
Que publishing books are
great.

www.photoshop.imageready
by Greg Simsic. Que. 2001.
$45. quepublishing.com

Reviewed by
Susan Stubbs

I chose this book from
the review table to learn
more about how to work
with images in Web
pages. Image slicing for
Web graphics is an excit-
ing way to put pictures

on Web pages and this
book provides a step by
step approach to show
you how.

The book comes with
excellent graphics to
accompany the tutorials.

I set up the preferences
for Photoshop and
Imageready according to
their instructions. This
optimizes the programs
for Web graphics produc-
tion. I would like to point
out that the book is meant
for Photoshop 6 and
Imageready, however
Photoshop 7 is already out
in retail stores. The book
is still up-to-date for
learning these Web tech-
niques, no matter which
version of Photoshop and
Imageready you have.

Rollovers, animations,

image slices, and image
optimization are shown in
tutorials in this book. I
found it easy to select the
item I wanted to learn and
just read that particular
chapter. Que has all the
example images and
source available at their
Website for downloading.
I did this and got a nice
installer executable, which
made a directory on my
hard drive for the ex-
amples. The book has lots
of sidebar color graphics
pointing out where the
needed tools are located
for each tutorial. One of
the best sections of the
book is about image
rollovers. After reading
this section I had a more
thorough understanding
of this Web graphic tech-
nique. Also there are
many sections for begin-
ners with tutorial items
like image transparency,
and how to save an image
in the best format.

There is a very good
section about fonts and
how to use text in Web
graphics. The book shows
when to use Photoshop to
work with a graphic and
when to use Imageready.

In each of the applica-
tions is a jump menu
which will toggle your
image to whichever appli-
cation you choose.

The last chapter shows
how to make a Web page
using many of the tech-
niques discussed in the
book. This is a good

www.photoshop.imageready
Book Review
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May Meeting Report

David Shapiro, Assistant District Attorney for Memphis and Shelby County, left no doubt
in anyone’s mind that identity theft is a serious local problem and that we are all at risk.
Identity theft, although a Class D felony in itself, is almost always a “piggyback” crime that
enables a criminal to engage in other illegal activities. Most com-
mon is credit card fraud, which may involve purchases or with-
drawals from ATM machines. Check fraud and driving offenses
may also be blamed on an innocent party following an identity
theft. Victims may not know of these offenses until long after they
have occurred, making it difficult to prove that someone else was
the true culprit!

Criminals use several methods to steal identities:
-take mail from mailboxes with raised flags
-give the Post Office a “moving” notice to divert mail
-go through the victim’s garbage
-pose as pollsters or survey takers on the telephone
-steal personnel records from companies
-change the mailing address at a credit card company
-open bank accounts and get loans in someone else’s name
Shapiro had several recommendations for helping prevent identity theft: Citizens should

be aware of how identity theft happens and realize that there is no way to be completely
protected. They should know what to do in the event identity theft occurs, and should
promptly report it to the authorities. David also recommends that everyone order and exam-
ine credit reports on themselves, and download an excellent document on identity theft from
www.consumer.gov. Get the file “idtheft.pdf,” which can be read or printed using Adobe
Acrobat Reader software.


